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The following is an informal manual for the QLS Convert program.  There's a lot of information here, 
so we suggest that you read the whole thing.  If you don't like to read manuals, and feel pretty 
comfortable with the program, then skip to the last section "Known bugs, etc". 
 
Overview 
 
QLS Convert is the replacement for the SD Convert program, whose purpose in life was to convert 
sound files between QLS sound file format and Digidesign's Sound Designer format.  QLS Convert 
contains many improvements over SD Convert, a summary is listed below: 
 
• Loads and saves soundfiles without having to switch to QLS. 
¥ Full support for all K250 sampling modes.  QLS Convert will automatically expand QLS sound files 
and will automatically compress Sound Designer sound files. 
¥ Sound file loop markers do not disappear in Sound Designer. 
¥ Automatically adds samples to QLS sound files to prevent that annoying message: "Sound too short 
for K250". 
¥ Allows editing of QLS sound file tuning information. 
¥ Allows many files to be processed at once. 
¥ MultiFinder compatible. 
¥ Many user controllable options. 
 
 
 
Using QLS Convert: The Menus 
 
The following is a description of the menus available in QLS Convert, and a discussion of how each 
one is used. 
 
File Menu 
 
Convert File to QLS... 
 
Select this menu item when you want to convert a single Sound Designer file to QLS format.  QLS 
Convert will first ask you to select one of three compression modes, Auto, None, or Manual.  Auto 
compression is the default and is recommended for most sounds.  No compression works exactly the 
same as the old SD Convert program, it's quick and dirty.  Manual compression is not recommended 
unless you understand this process well, and you're having difficulties with Auto compression, but you 
want better results than No compression. 
 
If you select Auto compression, QLS Convert does the following in order: 
 
• Asks you to open a Sound Designer file.  
¥ Displays a graphics window showing the natural envelope of the sound you have opened. 
¥ Automatically creates and displays a straight line segment envelope that matches the natural 
envelope closely. 
¥ Asks you for the name of the new QLS file you wish to create. 
¥ Asks you for various tuning information for the QLS file. 
¥ Processes (compresses) the Sound Designer file using the envelope that it created and creates a 
new QLS file. 
 
After all this is done, QLS Convert leaves the graphics window for examination, but the QLS file is 
already closed and ready for loading into a K250. 
 
If you select No compression, QLS Convert does the following in order: 
 
• Asks you to open a Sound Designer file.  



¥ Asks you for the name of the new QLS file you wish to create. 
¥ Asks you for various tuning information for the QLS file. 
¥ Converts the Sound Designer file to a QLS file. 
 
If you select Manual compression, QLS Convert does the following in order: 
 
• Asks you to open a Sound Designer file.  
¥ Displays a graphics window showing the natural envelope of the sound you have opened. 
¥ Enables the Manual menu. 
 
At this point you must use the Manual menu to proceed further.  See the description of the Manual 
menu below. 
 
Convert File from QLS... 
 
Select this menu item when you want to convert a QLS sound file to Sound Designer format.  QLS 
Convert will first ask you to select one of two expansion modes, Auto expansion or No expansion.  
Auto expansion is recommended and will automatically expand a compressed QLS sound when 
converting to Sound Designer format.  No expansion works the same as the old SD Convert program, 
quick and dirty.  Regardless of your choice, QLS Convert does the following in order after you make 
your selection: 
 
• Asks you to open a QLS sound file. 
¥ Asks you for the name of the new Sound Designer file you wish to create. 
¥ Processes and converts the file. 
 
At this point, the Sound Designer file is ready for editing. 
 
Get Soundfile from K250... 
 
This menu item allows you to transfer any soundfile from your K250 to your Macintosh. This eliminates 
the need to switch to QLS while using this program. The file transfer is performed exactly like it would 
be by QLS, so you need to connect a QLS cable between your Mac and your K250. Before using this 
item, you should use the item in the Options menu, "Set K250 Port..." to specify which Mac port you 
have the QLS cable connected to. 
 
Send Soundfile to K250... 
 
This menu item allows you to transfer any soundfile from your Macintosh to your K250. This eliminates 
the need to switch to QLS while using this program. The file transfer is performed exactly like it would 
be by QLS, so you need to connect a QLS cable between your Mac and your K250. Before using this 
item, you should use the item in the Options menu, "Set K250 Port..." to specify which Mac port you 
have the QLS cable connected to. 
 
 
Convert File List to QLS... 
 
This menu item is only enabled when a file list that contains Sound Designer files has been opened or 
created.  Selecting this menu item causes each file in the list to be converted from Sound Designer 
format to QLS sound file format. 
 
Convert File List from QLS... 
 
This menu item is only enabled when a file list that contains QLS sound files has been opened or 
created.  Selecting this menu item causes each file in the list to be converted from QLS sound file 
format to Sound Designer format. 
 
Open File List... 
 
Select this menu item when you want to open a file list which you have previously created and saved.  
Once the file list is open, it behaves exactly as if it had just been created. 
 



Save File List... 
 
This menu item is only enabled if there is an active file list;  that is, if you have just created a new file 
list or have opened an old one.  Select this menu item to save the current file list. 
 
Create File List... 
 
Select this menu item if you want to create a list of files to process.  See the description of file lists 
below. 
 
Transfer... 
 
Select this menu item if you want to transfer to another application without returning to the Finder.  If 
you are running MultiFinder, transferring to another application will cause the current application (QLS 
Convert) to be replaced by the new application. 
 
Quit... 
 
Select this menu item when you want to exit QLS Convert and return to the Finder. 
 
 
Options Menu 
 
Preferences... 
 
QLS Convert contains a rather extensive list of user controllable options.  Most of these were intended 
to serve two purposes, to allow the user to customize the look and feel of the application, and to allow 
the user to override the automatic nature of the application when the need arises.  Most of the 
configuration is done from the Preferences menu item in the Options menu.  When this item is 
selected, the preferences dialog is presented to the user. 
 
The two radio control buttons at the top of the dialog determine whether the rest of the dialog shows 
the preferences for processing a single file or a file list.  The two sets of preferences are totally 
independent of one another, thus the user can configure the processing of a single file to be totally 
different from the processing of multiple files.  In fact, the default settings for the preferences are to 
process a single file with the maximum amount of user-interaction required, and to process multiple 
files with the minimum amount of user-interaction. 
 
The "Ask for destination file" checkbox determines whether the user will be asked to select a 
destination file name each time a file is processed.  If this box is selected, then each time a file is 
processed a standard file dialog will appear asking the user to name the destination file and to choose 
a disk and folder for the file.  If this box is not selected, then a file name will be created for the 
destination file, and the file will be created in the same folder as the source file being processed. 
 
All compression (converting to QLS) and expansion (converting from QLS) options follow. 
 
Under Compression, the "Ask each time" checkbox determines whether the user will be asked to 
choose one of the three compression methods each time a file is processed.  The three compression 
modes are Auto, None, and Manual.  If the "Ask each time" checkbox is selected, a dialog will appear 
with these three modes as choices each time a file is processed.  If the checkbox is not selected, then 
the selected compression mode will be used for all files, and the user will never be asked to choose. 
 
Below this are two checkboxes for "Show graphics" and "Edit tuning".  If the "Show graphics" 
checkbox is selected, then each time a file is processed a graphics window will appear that shows the 
natural envelope of the sound, the loop point (if any), and the compression envelope.  Although 
unlabelled, each horizontal pixel represents 4 milliseconds of sound and each vertical pixel represents 
1 deciBel of amplitude.  The compression envelope is initially at 0 dB and extends for the entire length 
of the sound, thus it appears as a baseline.  Envelope segment endpoints are represented by little 
boxes; envelope segments as lines between the boxes.  If the file is looped, then the start of loop point 
is represented by a vertical dotted line that extends from the baseline to maximum amplitude.  The 
end of loop point is always assumed to be at the end of the sound and is consequently not displayed.  
The graphics window is useful for monitoring the progress of automatic compression and is essential 



for manual compression.  If the "Show graphics" checkbox is not selected, then the graphics window 
will not normally be shown.  The graphics window is always shown when processing with Manual 
compression and never shown when processing with No compression. 
 
If the "Edit tuning" checkbox is selected, then each time a file is processed, a dialog will appear asking 
the user to fill in tuning information for the K250 sound file. The user may edit the decay rate of the 
sound, the release rate of the sound, the volume adjust of the sound, the pitch adjustment of the 
sound, and whether the K250 anti-alias filter will track or anti-track the sound as it is transposed up. 
 
The expansion options are extremely simple.  The "Ask each time" checkbox functions exactly as the 
Compression "Ask each time" checkbox, but the possible expansion modes are different.  There are 
only two choices, Auto expansion and No expansion. 
 
Envelope Parameters... 
 
Selecting this menu item under the Options menu allows the user to change the default parameters for 
the envelope fitter.  These are the parameters used by QLS Convert when doing automatic 
compression.  When using manual compression, the user is asked for the envelope parameters, but 
these parameters will be used as defaults.  There are five parameters that QLS Convert uses to fit a 
straight line envelope to a sample's natural envelope.  They are: the maximum average error 
permissable (MaxAvgErr), the shortest segment length permissable (MinLength), the longest segment 
length permissable (MaxLength), a largest permissable overflow (OverFlow), and an error clip value 
(ErrClip).  The envelope fitter starts with the first sample envelope point and tries drawing straight line 
segments from this point to each successive sample envelope point.  While these points are within 
MinLength of the starting point, it will continue.  If these points are MaxLength from the starting point, it 
will terminate the current line segment.  If the average error between the segment and the sample 
envelope exceeds MaxAvgErr, it will terminate.  When calculating errors, it finds the vertical error 
between each sample envelope point and each corresponding point on the straight line segment.  If 
this error is negative and greater than OverFlow, the current segment is terminated (this serves to 
prevent the sample envelope from exceeding the straight line envelope by more than OverFlow).  It 
then takes the absolute value of this error.  If this error is greater than ErrClip, it is reduced to ErrClip 
(this serves to ignore any errors greater than ErrClip, provided that the OverFlow criteria is met).  The 
sum of all such errors are added up and divided by the horizontal length of the current straight line 
segment,  and this final average error is compared against MaxAvgErr. 
 
The parameter's units are not given - essentially they are in pixels.  The MinLength and MaxLength 
parameters are in horizontal pixels, and each horizontal pixel is 4 milliseconds of time;  thus if a length 
is set at 20 this actually means 80 msec.  The ErrClip and OverFlow parameters are in vertical pixels, 
which are actaully deciBels.  The MaxAvgErr parameter is actually deciBels per 4 msec, a rather 
strange unit.  What is desired is the smallest number of segments that fit the envelope shape 
accurately.  Although it is easy to fit the sample envelope accurately by using a million little segments, 
this will simply not work well, because the envelope playback mechanism of the K250 will get bogged 
down and will not be able to keep up, especially if you are playing polyphonically.  Also, the maximum 
allowable number of segments is 255, and segments should not be longer than 1 second in length nor 
shorter than 16 milliseconds. 
 
The easiest parameters to work with are the MaxAvgErr and Length parameters.  Increasing the 
MaxAvgErr cause fewer segments to be created and will allow a "looser" fit, whereas decreasing the 
MaxAvgErr parameter will cause the opposite - more segments and a "tighter" fit.   By making 
MinLength equal to MaxLength, all segments created will be this length regardless of the other 
parameters - this has the effect of simply chopping up the sample envelope into equal portions.  This 
envelope fitting algorithm is not sophisticated, efficient, or easily understandable, but it works tolerably 
well.  If you don't understand these parameters, don't change them. 
 
File Extensions... 
 
The File Extensions menu item in the Options menu allows the user to modify the default filenames 
that QLS Convert provides.  For example, when QLS Convert is converting the QLS file "Fido" to a 
Sound Designer file, it will automatically generate the name "Fido.sd" as the suggested name for the 
Sound Designer file.  It does this by appending a "file extension" to the file name.  In this case, the file 
extension is ".sd".  Selecting the File Extensions menu item allows the user to change the Sound 
Designer extension (".sd") and the QLS extension (".qls").  The extensions may be up to 4 characters 



in length (including the '.').  If the extension contains no characters, then QLS Convert will suggest the 
original file name as the destination file name.  If the preferences are set up to not ask for destination 
file name, then the original file name with the extension appended will automatically become the 
destination file name.  If this is true, and the extension contains no characters, then the destination file 
name will be the same as the original file name and an error will result when QLS Convert attempts to 
create the new file. 
 
Gain Settings... 
 
When QLS Convert is converting from one format to another using an automatic mode, it attempts to 
"normalize" the resultant sound file.  This means that it tries to make the destination samples as 
numerically large as possible without overflowing.  The number 32767 is the largest sample value QLS 
Convert will create in a destination sound file.  It is possible that QLS Convert will be off a little bit 
when processing a particular sound;  it may end up with a maximum sample value well below 32767, 
or it may end up exceeding 32767 in which case it will clip the resulting waveform.  A small maximum 
sample may result in a noisy sound, while a large number of clips may result in a sound will clicks or 
distortion.  After processing a sound, QLS Convert will display the maximum sample value and the 
number of clipped samples.  If there are a large number of clips, or if there is a small maximum sample 
value (less than 28000), you may want to adjust the gain settings to compensate.  There are two gain 
settings, one for compression (converting to QLS) and one for expansion (converting from QLS), and 
both gain settings are expressed in deciBels.  A positive gain will increase the maximum sample; a 
large positive gain will result in many clipped samples.  A negative gain will decrease the number of 
clips, or eliminate clippling altogether;  a large negative gain will result in a very small maximum value.  
One deciBel at an amplitude of 32767 is approximately 4000 counts.  Thus, if you have a sound with a 
maximum sample of 28000, increasing the gain by 1 dB will bring the maximum sample very close to 
clipping.  In general, you should not need to adjust the default gains (which are both 0 dB), and if you 
do, first try small adjustments between -1 and 1 dB. 
 
Save All Options 
 
Selecting this menu item causes all Option parameters to be saved to disk.  The next time you use 
QLS Convert, the saved parameters will be used.  Once you have a set of parameters that you like, 
save them and QLS Convert will always start up using them.  There is no need to worry about saving 
parameters, because you can always get back to the original factory defaults by selecting Revert to 
Defaults.  If you hear a beep after selecting Save All Options, it means that your disk is locked and that 
the save could not be accomplished. 
 
Revert to Defaults 
 
Selecting this menu item causes all Option parameters (Preferences, Envelope Parameters, File 
Extensions, and Gain Settings) to be restored to their factory default values.  This is a good thing to do 
if you have changed a lot of parameters and have gotten totally confused.  Note that you must still 
save these defaults if you want the program to always start up this way. 
 
Set K250 Port... 
 
This menu item is used in conjunction with the menu items "Get Soundfile from K250..." and "Send 
Soundfile to K250...". Use this item to tell the Macintosh what port (modem or printer) your K250 is 
connected to. 
 
End of part 1 
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Manual Menu 
 
The manual menu is only enabled when you are converting a file to QLS format and you have 
selected Manual compression. 
 
Smooth Samples 
 
Selecting Smooth Samples causes the natural sample envelope to be smoothed.  This is done by first 
maximizing adjacent samples, and then by averaging adjacent samples.  The results of the smooth 
are then displayed in the graphics window. 
 
Fit Envelope... 
 
Selecting Fit Envelope causes the existing envelope to be thrown away and a new envelope to be 
automatically created by a parameterized envelope fitting algorithm.  After selecting, you will be asked 
for the envelope parameters.  After selecting the parameters, QLS Convert generates an envelope 
that fits the natural sample envelope.  This process can take a while, especially for long sounds.  After 
it is done, the resulting envelope is displayed in the graphics window. 
 
Adjust Envelope 
 
Selecting Adjust Envelope causes the existing envelope to be adjusted so that it just sits on top of the 
natural sample envelope.  It first reverts the sample envelope to the original data (in case it has been 
smoothed), then it raises all the segments up until they are above the natural envelope, and then it 
drops the segments down until they hit the natural envelope.  After this is done,  the resulting envelope 
is displayed in the graphics window. 
 
Use Envelope 
 
Selecting Use Envelope indicates the you are satisfied with the current envelope, and that you want to 
compress the sound using this envelope. 
 
Cancel 
 
Selecting cancel causes the current file to be closed along with the graphics window.  Conversion to 
QLS format will not take place.  If Manual compression is confusing, select cancel and the next time 
select Auto compression. 
 
File Lists 
 
Often it is necessary to convert a group of files from one format to another.  Rather than doing each 
file one at a time, it is possible to create a list of the files you want to process and then process all the 
files at once.  QLS Convert allows the user to create a single list of files the user wants to process.  
The files contained in this list must all be either QLS sound files or Sound Designer files, but not a 
mixture of both.  To create a list of files to process, select the Create File List menu item from the File 
Menu.  You will then be asked to select a file which may be either a QLS file or a Sound Designer file.  
After selecting the file, you will be asked to select another file, but this time you may only select files of 
the same type as the first file selected.  In other words, if the first file you select is a QLS file, thereafter 
you will only be allowed to select QLS files.  When you are through selecting files you wish to process, 
click on the Cancel button.  All the files you have selected are now stored in the "File List".  If you wish, 
you may now save this list of files to a file by selecting the Save File List menu item from the File 
menu.  Later, you may open this "File List" file if you want to process the same list of files.  More 
importantly, you may now select the "Convert File List..." menu items in the File menu to process the 
list of files.  You will note that if the current file list contains only QLS files, then only the Convert File 
List From QLS menu item will be enabled.  If you have a lot of files that you will be converting back 
and forth between QLS format and  Sound Designer format, you may want to create and save two file 
lists, one listing all the QLS files and the other listing all the Sound Designer files.  You will note that 
the processing for a single file differs from that of a list of files.  This is controlled by the preferences 



you have set up with the Preferences menu item in the Options menu.  The default preferences for 
processing a file list cause the processing to continue without user intervention.  When processing a 
list of files, the user will not be asked for any information during processing, including the destination 
file names.  These will be generated automatically.  The user may change this by altering the 
preferences, but then the user will also be asked questions about each file processed. 
 
Edit Tuning Dialog 
 
The tuning dialog tells you at the top whether the tuning information was "recovered" from the Sound 
Designer file.  When QLS Convert (or SD Convert) converts a QLS file to Sound Designer format, it 
encodes the QLS specific tuning information into the comment field of the Sound Designer file.  This 
field can be accessed and changed by the Get Info command in Sound Designer.  Even if there is 
tuning information there, the field will appear empty and will function normally.  However, if you enter a 
comment into this field, the tuning information will be destroyed.  When a Sound Designer file with no 
tuning information is converted to QLS, the edit tuning dialog tells you that the tuning information could 
not be recovered from the Sound Designer file, and will provide suitable defaults. 
 
The decay rate is the rate at which the looping section will decay in amplitude.  The release rate is the 
rate at which the sound will decay after the key is released.  Both these values are expressed in 
dB/sec, and a positive value indicates positive decay (negative values are not allowed).  When the 
sound has no loop, the decay rate should be set to the maximum value (2663 dB/sec).  This is 
because the K250 will play a default looping section consisting of zero samples in place of a regular 
looping section.  If the decay rate is extremely quick, the channel will shut off immediately after this 
null loop begins to play (this is what you want).  If the decay is slow, the channel will continue playing 
zero samples and will not shut off (this is not what you want).  For the same reason, very small release 
rates do not work well with sounds that have no loop. 
 
The volume adjust field is a simple volume adjust in deciBels.  The range is -42 to 42 deciBels; 
however, large positive adjustments will cause the loss of touch sensitivity when played on the K250. 
 
The Tuning adjust field (pitch adjust) is a little strange, and you will probably not want to use it.  When 
a QLS file is converted to a Sound Designer file, whatever pitch adjustment has been made to the 
QLS file is converted into the appropriate sampling rate for Sound Designer.  For instance, if you 
sampled a QLS file at 25000 Hz, tuned it up 1 semitone, and converted it to Sound Designer format, 
you will see that the sampling rate is now 26487 Hz.  When converting back to QLS, QLS Convert 
allows you to change the pitch further, but there is no need to.  When the sound is loaded back into 
the K250, it will be at the same original pitch.  Thus, the tuning adjust field always defaults to 0. 
 
The filter tracking checkbox, when selected, causes the K250 anti-alias filters to track the sound as it 
is transposed up (thus the sound gets brighter as it is transposed up).  When not selected, the K250 
anti-alias filters will "anti-track" the sound as it is transposed up (thus the sound gets duller as it is 
transposed up).  This is useful for smoothing the transition between adjacent roots of sampled musical 
sounds. 
 
Also, the Cancel button does not cause the conversion process to be cancelled, but merely cancels 
any changes you may have made to the tuning parameters. 
 
 
 
Known bugs, unimplemented features, and tips 
 
 
File list bug 
 
File lists don't quite work correctly.  If you create a file list and then use it, you shouldn't notice any 
problem.  If you save the file list and reload it immediately, it will still work fine.  The problem occurs if 
you change the structure of your file system between the time you save the file list and the time you 
reload it.  It is possible that after reloading, the file list will not work correctly because QLS Convert will 
not be able to locate the directory that contains each file.  You will simply get the error, "can't open 
file".   
 
The console window 



 
The console window was originally for debugging, but is now indespensible for providing various 
status/error messages.  I could replace it with a more standard dialog that flashes messages, but I find 
the scrolling console to be more useful.  In any case, there is a bug in the console window.  If you 
allow more than 32767 lines of text to accumulate in the console, I'm pretty sure the program will 
crash.  Another problem is that as the console accumulates text, it eats up memory.  Both problems 
are alleviated by closing the console periodically.  This will not cause QLS Convert to exit, but will 
simply free up the memory used by the console.  The next time a message needs to be displayed, a 
new (empty) console will appear with the message. 
 
If you get lots of clips 
 
If you notice during conversion that a lot of samples are clipping, you can abort the conversion by 
pressing down the mouse button.  This will leave a partially built destination file which will surely fail if 
used, so keep this in mind.  When lots of samples are clipping, chances are that it will take a good 
long time before the conversion will complete because of the amount of messages being displayed on 
the console.  Also, you run the risk of exceeding the 32767 line limit in the console, or running out of 
memory.  When you see lots of clips (like hundreds), abort the process, turn down the gain, and try 
again. 
 
Normalize without compression 
 
If you are converting to QLS, and want to normalize a sound without compressng it, there is a cute 
way to do this.  Select the manual compression mode.  When the graphics window appears, select 
Adjust Envelope and then Use Envelope.  Do not select Smooth Samples or Fit Envelope.  The Adjust 
Envelope will simply take the existing horizontal envelope and raise it up until it is just resting on top of 
the natural sample envelope.  This is what you want for simple normalization.  (Because Use Envelope 
first does an Adjust Envelope, it is even quicker to simply select Use Envelope immediately after the 
graphics window appears).  This is a good way to process very short sounds, which tend to confuse 
the envelope fitter. 
 
Sound too short for K250 
 
One of the big problems with the old SD Convert was that it would allow you to create QLS sound files 
which QLS wouldn't load into the K250 because they were too short.  This problem has been fixed in 
QLS Convert, but it is important to understand how it has been fixed.  First of all, let me define two 
terms, the "span" and the "loop".  The span of a sound is the sound that occurs before the looping 
section (the attack portion).  The loop of a sound is the looping section itself (in K250-land, the loop 
refers to a sustain loop which always occurs at the end of a sound - it is not possible to have any 
sound after the loop).  Anyway, the problem is that the K250 does not like spans or loops to be less 
than 50 milliseconds in length, and QLS refuses to load such sounds.  QLS Convert fixes the problem 
by making both the span and the loop at least 50 milliseconds long.  If the sound has no loop and is 
less than 50 msec long, QLS Convert will append zero samples to the end of the span until it is at 
least 50 msec long.  If the sound has a loop, and the span is less than 50 msec long, QLS Convert 
makes the span longer by appending additional copies of the loop to the original span.  Finally, if the 
sound has a loop and the loop is too short, QLS Convert will simply append extra copies of the loop to 
the loop.  Note that none of these actions changes what you hear on the K250, and all of this happens 
transparently to the user.  However, if you notice that the lengths of the span and loop sometimes 
change after conversion, this is probably why. 
 
K250 software requirements 
 
Although QLS Convert should work with all K250's that have the QLS and sampling options, the 
compression modes will work best with K250 versions 6.1 and higher.  This is because the older K250 
software has some problems in the envelope playback mechanism which cause the actual playback 
envelope to lag slightly behind the desired envelope.  We're talking milliseconds here, but the effect 
can be quite noticable if the compression envelope has violent up and down transitions and the sound 
is several seconds long.  You may notice that the sound contains little noise bursts, or that the 
envelope of the sound isn't quite right.  Nevertheless, if you're processing standard decaying musical 
sounds, such as piano, drums, guitar, vibes, etc., you probably won't notice any problems with the 
older K250 software.  The problem is only evident when compressing sounds that have an erratic 
envelope. 



 
Transposition of compressed sounds 
 
Related to the above problem is a slight problem with transposing a sound that has been compressed 
with QLS Convert.  When playing the sound on the K250, if you transpose up a lot (more than a fifth), 
you may notice similar sonic strangeness as described above.  Again, this should only occur if the 
sound had an erratic envelope to start with, and chances are good that such sounds will not be 
transposed much anyway.  There is no fix for this and it does not get much better with 6.1 software.  
You may also notice some strangeness if you transpose down several octaves, but this is strange 
anyway. 
 
Envelopes to watch out for 
 
There are a few things to watch out for when creating compression envelopes.  If there are lots of little 
tiny envelope segments (like one per pixel) chances are good that this will severely compromise the 
playability of the K250.  Also, envelope segments shouldn't be too long.  In general, envelope 
segments should be between 16 msec and 1 second in length.  (This corresponds to MinLength and 
MaxLength values of 4 and 250, respectively). 
 
Loop markers disappear in Sound Designer 
 
Sound Designer files created by SD Convert had an annoying bug that would cause the loop markers 
to disappear in Sound Designer.  This problem has been fixed in QLS Convert.  If you have an old 
Sound Designer file created by SD Convert that has this problem, you can fix it by patching the file as 
follows.  The 16-bit (two byte) integer at location 172 (00AE hex) which probably contains a 15 (000F 
hex), must be changed to a 33 (0021 hex).  This can be done with FEdit, MacSnoop, etc. 
 
 
 


